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Abstract 
Cervical cancer is a cancer which occurs because of cervical epithelial cells 
undergo genetic mutation resultin in controlled cell division. Bulbs of bawang 
dayak are one of the typical Indonesian plants whose compounds have been 
studied, which is shown that has inhibits the growth of cervival cancer activity 
(HeLa Cell). The purpose of this research is to find a new compound candidates 
as anticervical cancer that derived from the compound of Bulbs of bawang dayak, 
so that it can be an alternative source of medicinal raw materials through 
molecullar docking methods on two receptors namely 5UUI and 3ERT. All of the 
compounds of bulbs of Bawang Dayak docked to target receptor using a program 
called AutoDock Tools. The method validation has been done with the valueof 
RMSD (Root Mean Square Deviation)  which is obtained 0,282Å and0,436Å. 
Analysis of results of the docking of molecules shows that eleutherinoside 
compounds A can be predicted to have the best interaction with the value of 
energy bonds in the amount of -9,55 kkal/mol on the 5UU1 receptor and -7,63 on 
3ERT receptor than comparative drugs 5 Flourourasil in the amount of -3,91 
kkal/mol on the 5UU1 receptor and -4,20 on the 3ERT receptor. To preADME test 
Caco-2 cell has amount of 11,77 nm/sec;HIS has amount of 74,29%, and plasma 
protein bond has amount 66,28%. This compound also fulfills the rules of 5 
Lipinski and not toxic. 

 
Key words: Cervical cancer,compounds of bulbs of Bawang Dayak, molecular 
docking 

 
STUDI PENAMBATAN MOLEKULSENYAWA DARI UMBI 

BAWANG DAYAK (Eleutherine Palmifolia (L) Merr.) SEBAGAI 
OBAT ANTIKANKER SERVIKS 

 
Abstrak 

Kanker serviks adalah kanker yang terjadi karena sel epitel serviks mengalami 
mutasi genetik sehingga terjadi pembelahan sel yang tidak terkendali. Umbi 
bawang dayak merupakan salah satu tumbuhan khas Indonesia yang 
senyawanya telah diteliti menunjukkan aktivitas menghambat pertumbuhan 
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kanker serviks (sel HeLa). Tujuan penelitian ini yaitu untuk mendapatkan 
kandidat senyawa baru sebagai antikanker serviks yang berasal dari senyawa 
umbi bawang Dayak sehingga dapat menjadi alternatif sumber bahan baku obat 
melalui metode penambatan molekul pada dua reseptor yaitu 5UU1 dan 3ERT. 
Semua senyawa umbi bawang Dayak ditambatkan pada reseptor target 
menggunakan program AutoDock Tools. Validasi metodetelah dilakukan dengan 
nilaiRMSD (Root Mean Square Deviation)yang diperoleh 0,282Å dan 0,436Å. 
Analisis hasil penambatan molekulmenunjukkan bahwa senyawa eleutherinoside 
A dapat diprediksi memiliki interaksi yang paling baik dengan nilai energi energi 
bebas (∆G) sebesar -9,55 kkal/mol pada reseptor 5UU1 dan -7,63 pada reseptor 
3ERT daripada obat pembanding 5 Fluorourasil sebesar -3,91 kkal/mol pada 
reseptor 5UU1 dan -4,20 kkal/mol pada reseptor 3ERT. Untuk uji preADME sel 
Caco-2 sebesar 11,77 nm/sec; HIA sebesar 74,29%; dan ikatan protein plasma 
sebesar 66,28%. Senyawa ini pun memenuhi aturan  Lipinski serta tidak bersifat 
toksik. 
 

 
Kata kunci:Kanker Serviks, Penambatan Molekul, Senyawa Umbi Bawang 
Dayak

 
Pendahuluan 

 

Masalah kesehatan reproduksi yang menyebabkan kematian nomor dua pada 
wanita adalah kanker serviks.1Menurut WHO tahun 2017, kanker serviks adalah kanker 
paling umum kedua di antara wanita di seluruh dunia dan menyebabkan sejumlah 
besar kematian di wilayah Asia Tenggara. Hampir 200.000 kasus baru kanker serviks 
terjadi di negara anggota wilayah SEA (South East Asia) yaitu Indonesia. Pada tahun 
2017, insiden yang terjadi hampir mencapai 32 per 100.000 jiwa dan tingkat kematian 
hampir 18 per 100.000 jiwa.2Sejumlah bukti menujukkan bahwa penyebab tahap awal 
terbentuknya sel kanker serviks disebabkan oleh HPV (Human Papiloma Virus). 
Faktor-faktor lain yang terlibat bersama HPV dalam menginduksi karsinogenesis servik 
yaitu hormon seks yang telah terbukti dalam meningkatkan ekspresi gen dari HPV 16 
dan HPV 18. Selain itu, di sebagian besar kasus kanker serviks muncul karena 
paparan esterogen yang sebagian besar sensitif pada leher rahim.3 

Telah diketahui bahwa reseptor ERɑ (Esterogen alfa) diperlukan dalam aktivitas 
karsinogenik esterogen dalam leher rahim dan esterogen yang memberikan tidak 
hanya untuk genesis tetapi juga untuk pemeliharaan serviks.4 Selain itu, terdapat 
sebuah protein yang juga terlibat dalam kanker serviks yaitu VHR (Vaccinia H1-related 
phosphatase).Kehilangan VHR menyebabkan penangkapan siklus sel dalam sel 
karsinoma HeLa, menunjukkan bahwa penghambatan VHR dapat  menjadi  
pendekatan  yang  berguna  untuk  menunjukkan aktivitas antikanker dengan 
menghentikan pertumbuhan sel kanker tanpa efek merugikan pada sel normal.4,5 

Pengobatan kanker yang paling umum dilakukan adalah pembedahan, radioterapi 
dan kemoterapi, namun belum didapatkan hasil yang optimal dari ketiga jenis terapi 
tersebut dengan efek samping yang cenderung membahayakan pasien.6 Pemanfaatan 
antikanker alami adalah salah satu cara alternatif dengan menggunakan tanaman yang 
berpotensi untuk menghambat pertumbuhan sel kanker seperti tanaman bawang 
dayak (Eleutherine palmifolia (L) Merr.).7 Berdasarkan penelitian yang dilakukan oleh 

Roihatul Mutiah8 pada tahun 2017, potensi bawang dayak sebagai tanaman obat 
multifungsi sangat besar sehingga perlu ditingkatkan penggunaanya sebagai obat 
modern. Bawang dayak (Eleutherine palmifolia (L) Merr.) merupakan salah satu 
tanaman yang mampu menghambat secara selektif pertumbuhan sel kanker serviks 
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HeLa. Adapun senyawa-senyawa yang terdapat pada tumbuhan bawang dayak 
diantaranya Eleutherine, Eleutherinol, Eleutherol, Eleuthoside B, Isoeleutherine, 
Ziganein, Eletherinoside A, Eleutherinoside B, Eleuthoside C dan Erythrolaccin. 

Studi penambatan molekul (molecular docking) adalah suatu proses komputasi 

untuk mencari ligan yang cocok secara geometris dan energi terendah ke situs 
pengikatan protein. Metode ini merupakan salah satu metode yang digunakan untuk 
meniru peristiwa interaksi suatu molekul ligan dengan protein yang menjadi targetnya 
pada uji in vitro melalui simulasi model menggunakan komputer. Molekular docking 

sering digunakan untuk memprediksi afinitas dan aktivitasmolekul kecil. Maka 
molecular docking memainkan peranan penting dalam desain obat secara 
rasional.9Pada penelitian ini akan dilakukan penambatan molekul senyawa-senyawa 
dari umbi bawang dayak sebagai ligan sehingga untuk ditambatkan pada reseptor ERɑ 
(Esterogen alfa) dan reseptor VHR (Vaccinia H1-related phosphatase) sebagai 
rangkaian pencarian obat antikanker serviks. 

 
Metode 
 

Alat 
Laptop Dell dengan spesifikasi Processor Intel® CoreTM i®-2520 CPU @2.50GHz 

2.50GHz RAM 4.00 GB dan HDD 250GB.Sistem Operasi Windows 10, 64-bit, 
dilengkapi dengan program MGL-Tools®, Discovery Studio Visualizer®, Notepad++®, 
serta situs Protein Data Bank, PubChem, Pre-ADMET dan Toxtree. 

 
Bahan 

Struktur tiga dimensi protein dari Reseptor ERα (Estrogen alfa) dan VHR (Vaccinia 
H-1 Related Phospatase) yang didapat dari Protein Data Bank, metode ktistalografi 
sinar-X dengan resolusi 2Å. Identitas makromolekul tersebut adalah 3ERT dan 5UU1 
berformat (.pdb).Struktur tiga dimensi ligan yang digunakan adalah senyawa-senyawa 
dari tumbuhan bawang dayak yang diunduh dari PubChem dengan situs 
http://pubchem.ncbi.nhl.nih.gov dengan format (.sdf) kemudian dikonversi dengan 
menggunakan Discovery Studio Visualizer® menjadi bentuk .pdb 
 
Prosedur Rinci 
Preparasi Reseptor 

Menggunakan program Discovery Studio Visualizer® dilakukan pemisahan antara 
makromolekul protein dengan residu seperti molekul air dan ligan alami. Hasil 
pemisahan tersebut disimpan dalam format .pdb. 
 
Preparasi Senyawa Uji (Ligan) 

Sebelum melakukan preparasi, dilakukan penentuan sifat fisikokimia senyawa 
berdasarkan Lipinski’s Rule of Five. Senyawa uji yang digunakan adalah senyawa dari 
umbi Bawang dayak (Eleutherine palmifolia (L) Merr.) yaitu senyawa Eleutherine, 
Eleutherinol, Eleutherol, Eleuthoside B, Isoeleutherine, Ziganein, Eletherinoside A, 
Eleutherinoside B, Eleuthoside C dan Erythrolaccin yang didapat melalui pengunduhan 

dari situs http://PubChem.ncbi.nlm.nih.gov dengan format .dpf kemudian senyawa 
yang diunduh dengan format .sdf kemudian dikonversi dengan bantuan program 
Discovery Studio Visualizer® menjadi senyawa dengan format .pdb. 

 
Validasi Metode 

Validasi metode dilakukan untuk mengetahui apakah program yang digunakan 
untuk penambatan molekul sesuai persyaratan atau tidak. Validasi metode molecular 
docking dilakukan dengan cara re-docking antara ligan bawaan dari reseptor target 
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menggunakan perangkat lunak Autodock Tools®. Analisis yang digunakan untuk 
mengevaluasi hasil validasi yaitu nilai RMSD, situs pengikatan yang ditemukan dan 
parameter yang digunakan dianggap valid jika hasil RMSD ≤ 2Å. 

 
Penambatan Molekul 
Persiapan Reseptor dan Struktur Uji 

Dalam pengaturan program Autodock Tools®, dibuat folder kerja khusus dengan 
cara pilih (File > Prefences > Set > Start up directory > Set > Accept). Kemudian buka 
reseptor yang sudah dipreparasi, pilih (File > Read molecule > Open). Kemudian pada 
reseptor tersebut ditambahkan atom hidrogen ke gugus polar dengan cara memilih 
(Edit > Hydrogen > Add > Polar Only > OK), simpan dengan format .pdbqt dengan cara 
pilih (Macromolekul > Output > Save as PDBQT). Setelah itu dimasukkan senyawa uji 
(Ligand > Output > Open). Setelah senyawa dibuka, dilakukan pengecekan rotasi 
senyawa uji dengan melihat titik rotasi dan mengoreksi kebenaran rotasi senyawa ligan 
yang diuji dengan cara pilih (Ligand > Torsion tree > Choose rotation), simpan dengan 
format .pdbqt dengan cara pilih (Ligand > Output > save as PDBQT. 

 
Mengatur Grid Box 

Pengaturan Grid Box dilakukan dengan membuka menu Grid pada Autodock 
Tools®. Kemudian dipilih Macromolekul untuk reseptor yang digunakan dan Ligand 
dari senyawa uji yang telah disimpan dengan format (.pdbqt) dari pilihan Choose > 
Accept, Grid Box diatur dengan mengatur koordinat X, Y dan Z sesuai koordinat ligan 
alami, dan disimpan dengan format .gpf (Grid > Output > save GPF pada folder yang 
telah ditentukan). 

 
Mengatur Parameter Docking 

Dalam pengaturan parameter docking dilakukan dengan memilih menu Docking 
dan menentukan reseptor dan ligan uji yang digunakan dengan memilih makromolekul 
(Docking > Ligand > Choose > Select ligand > Choose > save as PDBQT > Accept) 
kemudian diatur parameter (Docking > Output > Lamarckian GA (4.2) > save pada 
folder yang telah ditentukan. 

 
Running Docking 

Setelah semua pengaturan docking selesai kemudian running bisa dilakukan 
dengan menggunakan Autogrid4 dan Autodock4. Proses dapat dilakukan secara 
langsung melalui program Autodock Tools®. Setelah running selesai akan dihasilkan 
output dengan format .dlg yang dapat dibuka dengan bantuan program Notepad++®, 
kemudian dilihat parameter yang dihasilkan berupa (∆G dan Cluster) dan 
membandingkan hasil yang didapat satu dengan yang lainnya. 

 
Analisis dan Visualisasi Penambatan Molekul 

Hasil kalkulasi penambatan dapat dilihat pada output dalam format notepad++®. 
Penentuan konformasi ligan hasil penambatan dilakukan dengan memilih konformasi 
ligan yang memiliki energi ikatan yang paling rendah (posisi terbaik). 

Posisi dan orientasi ligan tersebut pada makromolekul, serta asam-asam amino 
yang terikat pada ligan divisualisaikan dengan menggunakan perangkat lunak 
Discovery Studio Visualizer® untuk melihat interaksi ligan terhadap active binding site 
pada reseptor. 

 
Pengujian Pre-ADME 

Pengujian yang dilakukan bertujuan untuk menganalisa parameter awal 
farmakokinetika yang meliputi absorpsi dan distribusi serta uji toksisitas yang meliputi 
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sifat mutagenik dan karsinogenik senyawa. Pengujian dilakukan dengan menggunakan 
program khusus yang dilakukan dengan menggunakan program khusus yang 
dilakukan secara online pada situs http://preadme.bmdrc.kr/. Struktur senyawa uji 
digambar dan kemudian diklik submit untuk dianalisa. Hasil yang didapat berupa data 

disimpan dalam format .pdb. 
 

Hasil 

 
 

 
 

Gambar 1. Visualisasi tumpang tindih ligan alami 5UU1 (Biru) dengan ligan hasil 
redocking (kuning) 

 

 
 

Gambar 2. Visualisasi tumpang tindih ligan alami 3ERT (Biru) dengan ligan hasil 

redocking (kuning) 

 
 
Tabel I.Grid Box, RMSD, Nilai Ikatan Energi, Ligan Alami, dan 5Fluorourasil 

Kode PDB Grid Box RMSD 
Ikatan 

Energi 5 
Fluorourasil 

Ikatan 
Energi Ligan 

Alami 
(kkal/mol) 

5UU1 
X : 0,539 

Y : -18,004 
Z : -13,408 

0,282Å -3,91 -8,79 

 
3ERT 
 

X : 30,282 
Y : -1,913 
Z : 24,207 

0,435Å -4,20 -10,64 
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Tabel II. Sifat Fisikokimia Senyawa Umbi Bawang Dayak Berdasarkan Aturan 5 
Lipinski 

Senyawa 
BM 

(g/mol) 
Log P 

Donor 
Hidrogen 

Akseptor
Hidrogen 

Refractory 
Molar 

Ket 

Eleutherine 272 2,33 0 4 72,37 Memenuhi 

Eleutherinol 256 3,03 2 4 70,73 Memenuhi 

Eleutherinoside 
A 

418 0,51 4 9 103,46 Memenuhi 

Eleutherinoside 
B 

612 -1,10 9 15 143,91 
Tidak 

memenuhi 

Eleutherol 244 2,78 1 4 65,99 Memenuhi 

Eleuthoside B 568 -1,91 7 14 131,35 
Tidak 

memenuhi 

Eleuthoside C 598 -1,42 8 14 141,85 
Tidak 

memenuhi 

Erytrolaccine 286 1,59 4 6 71,14 Memenuhi 

Isoeleutherine 272 2,33 0 4 72,37 Memenuhi 

Ziganein 254 2,18 2 4 67,82 Memenuhi 

 
Tabel III. Hasil Penambatan Molekuler Senyawa Umbi Bawang Dayak (5UU1) 

No. Ligan ∆G (kkal/mol) Konstanta inhibisi (nM) 

1 Ligan alami -8,79 357,99 

2 5 Fluorourasil -3,91 -1,360 

3 Eleutherine -7,93 1,55 

4 Eleutherinol -7,10 6,29 

5 Eleutherinoside A -9,55 99,41 

6 Eleutherinoside B -6,67 12,87 

7 Eleutherol -6,42 19,71 

8 Eleuthoside B -8,80 355,69 

9 Eleuthoside C -8,57 522,60 

10 Erytrolaccin -7,70 2,27 

11 Isoeleutherine -7,60 2,67 

12 Ziganein -7,93 1,53 
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Tabel IV. Hasil Penambatan Molekuler Senyawa Umbi Bawang Dayak (3ERT) 

No. Ligan ∆G (kkal/mol) Konstanta inhibisi (nM) 

1 Ligan alami -10,64 15,97 

2 5 Fluorourasil -4,20 833,28 

3 Eleutherine -7,44 3,53 

4 Eleutherinol -7,49 1,38 

5 Eleutherinoside A -7,63 2,57 

6 Eleutherinoside B -7,19 5,41 

7 Eleutherol -6,82 21,56 

8 Eleuthoside B -8,49 596,68 

9 Eleuthoside C -6,82 10,06 

10 Erytrolaccin -7,22 5,14 

11 Isoeleutherine -7,23 5,04 

12 Ziganein -6,66 13,15 

 
Tabel V. Hasil Analisis Ikatan Hidrogen dan Residu Asam Amino yang Terlibat (5UU1) 

No. Senyawa 
Jumlah ikatan 

hydrogen 
Residu asam amino 

1 Liganalami 3 (GLU122, LEU124, 
LYS61) 

GLU122, LEU124, LYS61, 
PRO101, LEU173, MET121, 

ALA185, VAL59, ILE35, ILE43 

2 5 Fluorourasil 3 (GLU122, LEU124, 
ALA185) 

GLU122, LEU124, ALA185, 
PRO101, VAL59 

3 Eleutherine 1 (LYS61) LYS61, GLY38, TYR77, 
MET121, ILE43, VAL59, 

LEU124, LEU173 

4 Eleutherinol 2 (LYS61, LEU124) LYS61, LEU124, LEU173, 
VAL59, ILE43, ALA185, 

MET121 

5 Eleutherinoside A 5 (LYS61, LEU124, 
GLU122, ILE35, 

ASP127) 

LYS61, LEU124, GLU122, 
ILE35, ASP127, GLY125, 
ILE43, VAL59, LEU173, 

PRO101, MET121, ALA185 

6 Eleutherinoside B 4 (ASN171, ALA170, 
SER37, LEU124) 

ASN171, ALA170, SER37, 
LEU124, ALA185, GLY38, 

VAL59, ILE43, ILE35, LEU173 

7 Eleutherol 2 (ALA185, LEU124) ALA185, LEU124, ARG123, 
ASP186, ILE43, LEU173, 
PRO101, MET121, VAL59 

8 Eleuthoside B 4 (LEU124, ALA170, 
ASP124, GLY125) 

LEU124, ALA170, ASP127, 
GLY125, SER37, ASP186, 
ALA185, LYS61, MET121, 

VAL59, ILE35, ILE43 
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9 Eleuthoside C 5 (GLU122, ALA185, 
GLY125, SER37, 

ALA170) 

GLU122, ALA185, GLY125, 
SER37, ALA170, ILE35, 
ALE43, VAL59, ILE126 

10 Erytrolaccine 3 (ALA185, GLU122, 
LEU124) 

ALA185, GLU122, LEU124, 
ILE35, ARG123, VAL59, 

ILE43, LEU173 

11 Isoeleutherine 1 (LYS61) LYS61, LEU173, VAL59, 
LEU124, ILE43, MET121 

12 Ziganein 2 (ALA185, LEU124) ALA185, LEU124, MET121, 
PRO101, ILE35, ILE43 

 
Tabel VI. Hasil Analisis Ikatan Hidrogendan Residu Asam Amino yang Terlibat (3ERT) 

No. Senyawa 
Jumlah ikatan 

hydrogen 
Residu asam amino 

1 Ligan alami 2 (GLU353, ARG394) 

GLU353, ARG394, ILE424, 
MET421, LEU525, ASP351, 
LEU346, MET343, LEU387, 

LEU391, ALA350 

2 5 Fluorourasil 2 (ARG412, MET421) 
ARG412, MET421, PHE425, 

LYS416, ASP426 

3 Eleutherine - 
MET288, LEU391, LEU387, 
LEU346, MET343, LEU525, 

HIS 524, MET421 

4 Eleutherinol 
3 (ARG394, GLU353, 

LEU346) 

ARG394, GLU353, LEU346, 
MET343, MET388, LEU428, 
MET421, ILE424,LEU387, 

ALA350 

5 Eleutherinoside A 
3 (GLU353, LEU346, 

THR347) 

GLU353, LEU346, THR347, 
ALA350, TRP383, MET528, 

MET343, LEU525 

 
6 

Eleutherinoside B 
4 (LEU387, MET343, 

THR347, ASP351) 

LEU387, MET343, THR347, 
ASP351, ILE424, LEU428, 
LEU391, MET421, GLU355 

7 Eleutherol 1 (ARG394) 
ARG394, LEU428, MET388, 
LEU391, MET421, LEU346, 

LEU349 

8 Eleuthoside B 
3 (ASP351, 

THR347,GLU353) 

ASP351, THR347, 
GLU353,MET343,LEU387, 
LEU384,MET421,ALA350 

9 Eleuthoside C 
3 (THR347, ASP351, 

LEU384) 

THR347, ASP351, LEU387, 
MET343, ILE424, LEU428, 
LEU384, ALA350, GLU353, 

MET388 

10 Erytrolaccin 
3 (ARG394, GLU353, 

THR347) 

ARG394, GLU353, THR347, 
ALA350, LEU525, LEU428, 
MET388, LEU391, LEU387 

11 Isoeleutherine - 
LEU387, MET388, LEU391, 
GLU353, LEU346, MET343, 
LEU525, HIS524,MET421 

12 Ziganein 1 (LEU346) 
LEU346, LEU525, MET343, 
MET421, HIS524, LEU349 
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Tabel VII. Uji PreADME (Absorpsi dan Distribusi) Senyawa Umbi Bawang Dayak dan 

Obat Pembanding 

No Senyawa Caco-2 (nm.sec-1) HIA (%) 
Protein Plasma 

Binding (%) 

1 Ligan alami (7DZ) 31,99 97,61 86,31 

2 
Ligan alami (4-

hydroxytamoxifen) 
26,30 93,56 64,42 

3 5 Fluorourasil 31,56 96,55 73,55 

4 Eleutherine 31,31 98,22 85,69 

5 Eleutherinol 21, 30 93,03 95,80 

6 Eleutherinoside A 11,77 74,29 66,28 

7 Eleutherinoside B 8,42 70,79 32,34 

8 Eleutherol 8,48 95,51 86,01 

9 Eleuthoside B 15,72 74,29 36,78 

10 Eleuthoside C 9,51 76,39 30,95 

11 Erytrolaccine 20,81 75,72 98,62 

12 Isoeleutherine 31,31 98,22 85,69 

13 Ziganein 20,93 92,59 96,84 

 

Tabel VIII. Uji Toksisitas Senyawa Umbi Bawang Dayak dan Obat Pembanding 

No Senyawa Ligan  Kroes TTC decision tree 

1 Ligan alami (7DZ) 1 

2 Ligan alami (4-hidroxytamoxifen) 2 

3 5 Fluorourasil 2 

4 Eleutherine 2 

5 Eleutherinol 2 

6 Eleutherinoside A 1 

7 Eleutherinoside B 1 

8 Eleutherol  1 

9 Eleuthoside B 1 

10 Eleuthoside C 1 

11 Erytrolaccin  2 

12 Isoeleutherine 2 

13 Ziganein  2 
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Pembahasan 
 

Struktur reseptor VHR diunduh dari situs PDB dengan kode 5UU1 sedangkan 
struktur reseptor ERα (Estrogen alfa) diunduh dengan kode 3ERT. Sebelum dilakukan 
penambatan molekul dengan senyawa uji, terlebih dahulu dilakukan validasi dengan 
cara memisahkan ligan alami dari reseptornya dengan Discovery Studio Visualizer® 
kemudian ditambatkan kembali menggunakan AutoDock Tools® untuk mendapatkan 
nilai RMSD. 

Nilai RMSD yang diperoleh dari reseptor dengan kode 5UU1 adalah 0,282Å dan 
kode 3ERT adalah 0,436Å.  Metode docking dikatakan valid jika memiliki nilai RMSD ≤ 
2Å. RMSD (Root Mean Square Deviation) adalah parameter yang digunakan untuk 
mengevaluasi kemiripan dua buah struktur.10 Nilai RMSD yang semakin kecil 
menunjukkan posisi ligan hasil re-docking yang makin mendekati posisi ligan 
kristalografi.11 

Ligan yang digunakan dalam penelitian ini adalah senyawa dari umbi bawang 
dayak (Eleutherine palmifolia (L) Merr.). Struktur tiga dimensi ligan diunduh dari situs 
PubChem kemudian disimpan dalam format (.pdb) untuk dapat ditambatkan ke 
reseptor target. 

Sebelum dilakukan proses penambatan, terlebih dahulu dipersiapkan parameter 
yang dibutuhkan untuk melakukan penambatan yaitu parameter grid (Grid Parameter 
File) dan parameter penambatan (Docking Parameter File). Pengaturan grid meliputi 
penentuan koordinat dan volume. Koordinat yang digunakan dalam penambatan 
molekul pada reseptor VHR yakni dengan pusat koordinat (X,Y,Z) berturut-turut yaitu 
0.539, -18.004 dan -13.408. Sedangkan pada reseptor ERα yakni dengan pusat 
koordinat (X,Y,Z) berturut-turut yaitu 30.282, -1.913, dan 24.207. Volume grid  
penambatan yang digunakan dalam penelitian ini adalah 40 x 40 x 40 Å dengan 
spacing 0,375. Pada parameter penambatan, dilakukan perubahan pada Number of 
GA Runs menjadi 100. Setiap Number of GA Runs digunakan Maximum Number of 
Evaluation Medium, yaitu 2.500.000. 

Parameter yang diamati untuk penentuan afinitas senyawa uji terhadap reseptor 
adalah nilai ikatan energi (ΔG), konstanta inhibisi (Ki), dan residu asam amino.  Afinitas 
senyawa uji terhadap reseptor ditentukan oleh nilai ikatan energi dan konstanta 
inhibisi. Semakin negatif nilai ikatan energi dan semakin kecil nilai konstanta inhibisi 
menunjukkan afinitas ligan yang semakin tinggi.12 Selain itu juga, diamati hasil 
visualisasi penambatan serta interaksi yang terjadi. 

Drug-likeness mengacu pada kemiripan suatu senyawa dengan obat oral. Metode 
yang digunakan untuk mengevaluasi drug-likeness yaitu menggunakan aturan 
Lipinski’s Rule of Five. Aturan tersebut menetapkan bahwa molekul obat harus 
mempunyai massa molekul relatif  ≤500 g/mol, nilai Log P ≤5, donor ikatan hidrogen 
≤5, akseptor hidrogen ≤10, dan refractory molar antara 40-130.13 

Nilai berat molekul berkaitan dengan proses distribusi obat. Proses distribusi obat 
terjadi dengan cara menembus membran biologis. Berbeda dengan obat yang memiliki 
bobot molekul kecil akan memudahkan untuk menembus membran biologis.13 

Nilai Log P berkaitan dengan lipofilitas atau hidrofobisitas yaitu kemampuan suatu 
senyawa kimia untuk larut dalam lemak, minyak, lipid, dan pelarut non polar. Dalam 
konteks farmakokinetik, untuk obat yang diabsorpsi melaui oral, secara normal harus 
melewati lipid bilayer dalam epithelium intestinal. Agar sistem transport efisien, obat 
harus cukup hidrofobik untuk menembus ke dalam lipid bilayer, tetapi tidak boleh 
terlalu hidrofobik karena jika obat sudah masuk kedalam lipid bilayer, tidak dapat 
menembus keluar lagi yang akan menyebabkan obat tersebut toksik karena bertahan 
lebih lama di dalam tubuh.13 
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Nilai donor dan akseptor ikatan hidrogen berhubungan dengan aktivitas biologis 
dari suatu molekul obat. Ikatan hidrogen dapat mempengaruhi sifat-sifat kimia-fisika 
senyawa, seperti titik didih, titik lebur, kelarutan dalam air, perubahan sifat-sifat 
tersebut dapat berpengaruh terhadap aktivitas biologis senyawa. Refractory molar 
merupakan suatu nilai total polarisabilitas dari molekul obat yang sangat bergantung 
pada suhu, indeks bias dan tekanan.13 

Berdasarkan aturan Lipinski’s Rule of Five hampir semua senyawa umbi bawang 
dayak (Eleutherine palmifolia (L) Merr.) memenuhi aturan kecuali senyawa 
Eleutherinoside B, Eleuthoside B, dan Eleuthoside C sehingga dapat diprediksi bahwa 
hampir semua senyawa dari umbi bawang dayak  memiliki absorpsi yang baik 
digunakan sebagai sediaan oral kecuali Eleutherinoside B, Eleuthoside B, dan 
Eleuthoside C. 

Analisis senyawa uji yang telah ditambatkan dengan reseptor target dilihat melalui 
skor penambatan dan melalui visualisasi dengan melihat residu asam amino dan 
jumlah ikatan hidrogen yang terbentuk dari hasil intraksi dengan masing-masing 
senyawa uji dan reseptor target. Skor berupa nilai ikatan energi dan konstanta inhibisi, 
dapat dilihat pada berkas .dlg yang merupakan keluaran berkas pada hasil AutoDock. 

Semakin rendah nilai ikatan energi menunjukkan semakin stabilnya ikatan antara 
ligan dan reseptor target. Sedangkan, semakin rendah nilai konstanta inhibisi, maka 
penghambatan yang ditunjukkan oleh ligan terhadap aktivitas reseptor target semakin 
efektif. 

Analisis secara visual dilakukan dengan membandingkan interaksi antara senyawa 
uji dengan residu asam amino dan ikatan hidrogen pada reseptor target. Analisis 
dilakukan dengan menggunakan perangkat lunak Discovery Studio Visualizer® untuk 
melihat residu asam amino dan ikatan hidrogen yang terbentuk. 

Dari 10 senyawa uji yang ditambatkan, senyawa Eleutherinoside A merupakan 
senyawa yang memiliki nilai ikatan energi paling rendah yaitu terhadap reseptor 5UU1 
sebesar -9,55 kkal/mol dengan nilai konstanta inhibisi 99,41 nM dan pada reseptor 
3ERT sebesar -7,63 kkal/mol dengan nilai konstanta inhibisi 2,57 nM sedangkan nilai 
ikatan energi 5 Fluorourasil sebagai ligan pembanding terhadap reseptor 5UU1 adalah 
-3,91 kkal/mol dengan konstanta inhibisi sebesar 1,360 nM dan terhadap reseptor 
3ERT sebesar -4,20 kkal/mol dengan nilai konstanta inhibisi 833,28 nM. Serta nilai 
ikatan energi ligan alami dari reseptor 5UU1 adalah -8,79 kkal/mol dengan konstanta 
inhibisi 357,99 nM dan dari reseptor 3ERT adalah sebesar -10,64 kkal/mol dengan 
kostanta inhibisi 15,97 nM. Hal tersebut menunjukkan bahwa senyawa Eleutherinoside 
A memiliki nilai ikatan energi lebih rendah dari 5 Fluorourasil, artinya senyawa tersebut 
diprediksi memiliki interaksi yang lebih baik terhadap reseptor VHR dan ERα 
dibandingkan 5 Fluorourasil dan merupakan senyawa uji terbaik pada penelitian ini 
sehingga bisa dijadikan sebagai calon kandidat obat antikanker serviks 

Berdasarkan data yang telah dihasilkan, terdapat interaksi antara ligan alami dari 
reseptor 5UU1 dengan residu asam amino dimana ada 3 ikatan hidrogen dan interaksi 
antara ligan alami dari reseptor 3ERT dengan residu asam amino yaitu ada 2 ikatan 
hidrogen. Sedangkan 5 Fluorourasil terhadap reseptor 5UU1 memiliki 3 ikatan 
hidrogen dan terhadap reseptor 3ERT memiliki 2 ikatan hidrogen. Senyawa uji terbaik 
terhadap reseptor 5UU1 memiliki 5 ikatan hidrogen dan terhadap reseptor 3ERT 
memiliki 3 ikatan hidrogen. Ikatan hidrogen merupakan ikatan antar atom H yang 
mempunyai muatan positif dengan atom lain yang bersifat elektronegatif seperti O, N, 
F.14 

Hasil penambatan 5 Fluorourasil terhadap reseptor 5UU1 menunjukkan ikatan 
hidrogen dengan residu asam amino GLU122, LEU124, ALA185, dan penambatan 5 
Fluorourasil terhadap reseptor 3ERT menunjukkan ikatan hidrogen dengan residu 
asam amino ARG412 dan MET421. Sedangkan untuk hasil penambatan senyawa uji 
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Eleutherinoside A terhadap reseptor 5UU1 menunjukkan ikatan hidrogen dengan asam 
amino LYS61, LEU124, GLU122, ILE35, dan ASP127. Serta terhadap reseptor 3ERT 
menunjukkan ikatan hidrogen dengan asam amino GLU353, LEU346, dan THR347. 

Untuk memprediksi profil farmakokinetik (absorpsi dan distribusi) senyawa umbi 
bawang dayak (Eleutherine palmifolia (L) Merr.). Prediksi parameter absorpsi dan 
distribusi dapat diakses melalui situs http://preadmet.bmdrc.org/. Struktur kimia dari 
senyawa digambar kemudian diklik submit, secara otomatis program akan menghitung 
dan menampilkan nilai prediksi dari parameter-parameter tersedia. 

Prediksi absorpsi obat dikaji berdasarkan kemampuan obat terabsorpsi pada usus 
HIA (Human Intestinal Absorption) dan kemampuan permeabilitas pada sel Caco-2. 
Sel Caco-2 merupakan model in vitro untuk mengetahui transport obat melalui epitel 
intestinal yang berasal dari adenocarsinoma kolon manusia yang memiliki jalur 
transportasi ganda. HIA merupakan penjumlahan dari biovailabilitas dan absorpsi yang 
dievaluasi dari rasio eksresi melalui urin, empedu dan feses.15 

Parameter distribusi yang diprediksi berdasarkan keterikatan pada protein plasma. 
Pada umumnya hanya obat dalam bentuk tidak terikat yang dapat berdifusi menembus 
membran sel dan berinteraksi dengan target farmakologi sehingga ikatan protein 
plasma berperan penting dalam efikasi obat. PPB (Plasma Protein Binding) merupakan 
fraksi obat yang tersedia dalam bentuk bebas untuk didistribusikan ke berbagai 
jaringan.15 

Semua senyawa dari umbi bawang dayak memiliki nilai Caco-2 yang berada pada 
rentang 4-70 (Medium permeability), dan memiliki nilai HIA yang berada pada pada 
rentang 70-100%. Artinya semua senyawa dari umbi bawang dayak dapat terabsorpsi 
dengan baik. 

Profil distribusi berdasarkan keterikatan pada protein plasma menunjukkan bahwa 
beberapa senyawa umbi bawang dayak terikat kuat pada protein plasma karena 
memiliki nilai PPB lebih dari 90% seperti Eleutherinol, Erytrolaccin dan Ziganein 
sehingga diprediksi memiliki kemampuan terdistribusi yang kurang dalam tubuh, 
namun sebagian besar tidak terikat kuat pada protein plasma sehingga dapat 
diprediksi sebagian besar senyawa umbi bawang dayak memiliki kemampuan 
terdistribusi yang baik dalam tubuh. 

Prediksi toksisitas dilakukan dengan menggunakan program Toxtree®. Uji ini 
digunakan memprediksi tingkat toksisitas dari suatu senyawa bagi tubuh manusia. 
Pada uji menggunakan parameter Kroes TTC decision tree untuk memperkirakan 
ambang batas paparan senyawa obat pada munusia. 
Berdasarkan parameter Kroes TTC decision tree hampir semua senyawa dari umbi 
bawang dayak (Eleutherine palmifolia (L) Merr.) memiliki nilai ambang batas paparan 
yang aman, sedangkan beberapa senyawa umbi bawang dayak (Eleutherine, 
Eleutherinol, Erytrolaccin, Isoeleutherine, dan Ziganein) memiliki nilai ambang batas 
paparan yaitu tidak lebih dari 5 µg/hari. Ini didasarkan pada analisis data dosis-respon 
untuk senyawa karsinogenik.16 

 

Kesimpulan 
 

Berdasarkan hasil penelitian dapat disimpulkan bahwa senyawa Eleutherinoside A  
terhadap  reseptor 5UU1 memiliki nilai  ikatan  energi  sebesar-9,55 kkal/mol dengan 
konstanta inhibisi 99,41 nM, senyawa Eleutherinoside A terhadap reseptor 3ERT 
memiliki nilai ikatan energi sebesar -7,63 kkal/mol dengan konstanta inhibisi 2,57 nM 
yang lebih baik dibandingkan 5 Fluorourasil sebagai obat pembanding dengan nilai 
ikatan energi sebesar –3,91 kkal/mol dengan konstanta inhibisi 1,360 nM pada 
reseptor 5UU1 dan 5 Fluorourasil yang memiliki nilai ikatan energi sebesar -4,20 
kkal/mol dengan kostanta inhibisi 833,28 nM pada reseptor 3ERT. Senyawa 
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Eleutherinoside A selain memenuhi aturan Lipinski’s rule of Five, juga memiliki nilai 
absorpsi dan distribusi yang baik, serta memiliki nilai uji toksisitas ambang batas 
paparan yang aman. 
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